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Chapter 1: Prerequisites

Read the information in this section before deploying the Operations Analytics All-in-One for HP
OneView Appliance.

Management Environment

This document provides information about setting up the Operations Analytics All-in-One for HP
OneView Appliance and enabling the integration between Operations Analytics and HP OneView. It
provides additional information about how to scale out the Operations Analytics All-in-One for HP
OneView Appliance to a distributed environment if the need arises.

The Operations Analytics All-in-One for HP OneView Appliance can typically collect data from no more
than 640 nodes. This number could be significantly less, depending on the amount of data each
collection is receiving and the amount of data each data center node is generating.

Note: The Operations Analytics All-in-One for HP OneView Appliance does not support the
configuration of other types of collections. Only Operations Analytics All-in-One for HP OneView
Appliance collections that are configured as explained in "About Data Collections for the

HP Operations Analytics - HP OneView Integration" on page 37 are supported.

For larger environments, you must scale out your Operations Analytics All-in-One for HP OneView
Appliance to use a distributed environment. For example, for larger environments, you must configure
collections on a separate Operations Analytics Collector Appliance. To expand this Operations
Analytics All-in-One for HP OneView Appliance to a distributed environment, complete the tasks
shown in "Expanding to a Distributed Operations Analytics " on page 40.

System Requirements

The Operations Analytics All-in-One for HP OneView Appliance is a virtual appliance you deploy using
an .ova file. This .ova file needs to be deployed in the VMware virtual center before it can be used. To
deploy the Operations Analytics All-in-One for HP OneView Appliance, the servers must meet the
following requirements:

o Minimum memory required for the Virtual Machine: 24 GB
« Minimum disk space required for the Virtual Appliance: 200 GB
e Minimum CPU requirements: 4 CPUs

« IP Address: The Operations Analytics All-in-One for HP OneView Appliance installation needs
either a static IP address or a permanently-leased DHCP IP address and the IP address must
resolve to a valid fully-qualified-domain-name.
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Any command examples shown in this document as being run by an opsa user can also be run by a root
user.

Note: The system clocks for the HP OneView server and the Operations Analytics All-in-One for
HP OneView Appliance must be synchronized.

Note: $OPSA HOME is set to /opt/HP/opsa in the Operations Analytics All-in-One for HP OneView
Appliance.

HP Operations Analytics All-in-One for HP
OneView Appliance Port Mapping

The well-known network ports described in the section need to be open in a secured environment for
the Operations Analytics All-in-One for HP OneView Appliance to be able to function and collect data
from HP OneView.

The communication ports shown in "Well-Known Port Mapping" below must be open on theOperations
Analytics All-in-One for HP OneView Appliance.

Well-Known Port Mapping

Port Purpose
443 Communication with REST interface
514 (UDP) Obtains syslog messages from HP OneView

5671 Communication with the State-Change Message Bus (SCMB) and the Metric
Streaming Message Bus (MSMB)
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Chapter 2: Setting up the HP Operations
Analytics All-in-One for HP OneView
Appliance

Follow the instructions in this section to deploy, power on, and test the Operations Analytics All-in-One
for HP OneView Appliance.

Caution: Operations Analytics uses Logger 6.0 with the reporting feature deactivated (the
Operations Analytics license does not include this Logger feature). Do not attempt to activate the
reporting mechanism in Logger.

Note: Operations Analytics integrates with HP OneView so you can view analytics and summary
information using management data from HP OneView (log and metric data).

Note: The Operations Analytics Server Appliance and the HP OneView Server must each be able to
resolve each other's fully-qualified domain names for the Operations Analytics - HP OneView
integration to function correctly.

Note: This manual includes examples that show script usage, command line usage, command
line syntax, and file editing. If you copy and paste any examples from this manual, carefully review
the results of your paste before running a command or saving a file.

1. Gotothe Software Depot Site.
2. Search for HP Operations Analytics for HP OneView.

3. Download HP Operations Analytics 2.31 OneView Virtual Appliance and extract the product
files to a local directory.

4. Logon tothe VMware ESX or VMware workstation.

Note: You must deploy Operations Analytics into a VMware vSphere environment. Do not
deploy Operations Analytics directly to an ESX Server host.

5. Select File -> Deploy OVF Template.

6. Enterthe URL or the file path of the HP_Opsa_OneView_OVF10.ova file, based on where you
extracted the product files; then click Next.
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7. Specify a name and location for the deployed template.

8. Follow the instructions to select the host or cluster on which you want to deploy the Server

Appliance; then click Next.
9. Select aresource pool.

10. Select the destination storage for the Server Appliance files; then click Next.

11. Select the format on which you want to store the virtual disks; then click Next. A display similar to

the following should appear:

@ Deploy OVF Template

L

B

Properties

Customize the software solution for this deplayment.

Source

OVF Template Details
End User License Agreement
MName and Location
Host | Cluster
Resource Pool
Storage

Disk Format

Metwork Mapping
Properties

Ready to Complete

Application

DHCP or Static IP

|pHcr ~|

Host Name
The VA host name

»

Static IP Address
The IF address for this interface. Leave blank if DHCP is desired.

m

Subnet Mask IP
The netmask or prefix for this interface. Leave blank if DHCP is desired.

Default Gateway
The default gateway address for this VM. Leave blank if DHCP is desired.

DHNS 1
DM51IP address. Leave blank if DHCP is desired.

DNS 2

12. Enter the network properties by specifying the field values shown in the following table.

HP Operations Analytics (2.31)
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Note: If you are using VMware Vcenter 5.x for this installation, a User Interface appears to
help you enter these values. If the User Interface does not appear, see the User’s Guide to
Deploying vApps and Virtual Appliances, available from
http://www.vmware.com/support/developer/studio/studio26/va_user.pdf (page 17) for
network configuration instructions.

Note: You can configure the Operations Analytics All-in-One for HP OneView Appliance to
work with static IP addresses or permanently-leased DHCP IP addresses as shown in
"Network Properties" below.

Network Properties

Address
Type Field

DHCP DHCP or
Static IP

Host Name
(The

VA Host
Name)

All Fields
DNS
Timezone

Static DHCP or
Static IP

Host Name
(The

VA Host
Name)

Static
IP Address

Subnet
Mask IP

HP Operations Analytics (2.31)

Value

Select DHCP

Note: The Operations Analytics installation needs either static IP
addresses or permanently-leased DHCP IP addresses.

Enter the fully-qualified domain name of the Operations Analytics All-in-
One for HP OneView Appliance.

Leave all other fields blank.
The IP address of the DNS Server.
Select the desired timezone setting.

Select Static

Enter the fully-qualified domain name of the Operations Analytics All-in-
One for HP OneView Appliance.

The IP address of the server.

The network mask for your network.

Page 9 of 73



HP Operations Analytics for HP OneView Installation, Integration, and Upgrade Guide
Chapter 2: Setting up the HP Operations Analytics All-in-One for HP OneView Appliance

Network Properties, continued

Address
Type Field Value

Default The fully-qualified domain name or IP address of the network's default
Gateway gateway.

DNS The IP address of the DNS Server.

Timezone @ Select the desired timezone setting.

13. Make sure you entered the correct network settings and hostname (from the previous step); then
click Next.

14. Click Finish.

15. Power on the virtual appliance.

Note: After you deploy the virtual appliance, you should upgrade the VMWare Tools for the
appliance as described in the VMWare Upgrade Instructions. At this printing, you can obtain
this document using the following link: http://pubs.vmware.com/vsphere-
50/index.jsp#com.vmware.vmtools.install.doc/GUID-08BB9465-D40A-4E 16-9E 15-
8C016CC8166F.html

Terminology Used in this Document

Operations Analytics All-in-One for HP OneView Appliance: A self-contained system that
combines the Operations Analytics Server Appliance, Collector Appliance, Vertica Database, and the
HP ArcSight Logger virtual appliance.

Collection: A collection defines the data to be collected and corresponds to a database table in which
the Operations Analytics Collector Appliance stores the data.Collections can be separated by tenant
and collection information cannot be shared among tenants.

Common Event Format (CEF): The standard data format of HP ArcSight Logger.

Default Tenant: This Operations Analytics All-in-One for HP OneView Appliance document uses the
default Tenant, opsa_default and its corresponding default tenant username (opsatenantadmin) and
password (opsatenantadmin). The Operations Analytics All-in-One for HP OneView Appliance is not
intended to fully demonstrate the tenant model as explained in the Tenant definition in this section.

Tenant: Operations Analytics gathers metrics, topology, event, and log file data from a diverse set of
possible data sources. Tenants enable you to separate information from these data sources into
groups, such as collections, user accounts, and user groups. Collections can be separated by tenant
and collection information cannot be shared among tenants.

Virtual Appliance: A virtual appliance, also referred to as appliance in this document, is a self
contained system that is made by combining a software application, such as Operations Analytics
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software, with just enough operating system for it to run optimally on industry standard hardware or a
virtual machine, such as VMware.

Configure the Database

Operations Analytics includes vertica-7.1.1-.x86_64.RHEL5.rpm for the Vertica installation and
vertica-R-lang-7.1.1-3.x86_64.RHEL5.rpm and vertica-R-lang-7.1.1-5.x86_64.RHEL5.rpm for the R
Language Pack from Vertica. Use these packages for optimum Vertica performance. You can find
these packages inthe /opt/HP/opsa/installation/rpmfolder onthe Operations Analytics All-in-
One for HP OneView Appliance.

The Vertica database server should already be configured for the Operations Analytics All-in-One for
HP OneView Appliance. It should be configured with a MAXMEMORYSIZE of 50% of the machine’s RAM
(using a 24GB RAM machine). If it is not, do the following:

1. Logonto the Vertica server as an opsa user.

2. Run the following command to become the root user: su -

3. Run the following command to become the Linux dbadmin user: su - dbadmin
4. Enter the following command to access the SQL console: dbadmin$>VSQL

5. Enter the following command from the SQL console: ALTER RESOURCE POOL general
MAXMEMORYSIZE '12G';

6. Exitthe VSQL console using the following sequence:
a. \q
b. Enter

7. Restart the Vertica database by running /opt/vertica/bin/admintools and restarting the
opsadb database.

8. Runthe $0PSA_HOME/bin/opsa-server restart command on the Operations Analytics All-in-
One for HP OneView Appliance for the changes to take effect.

Note: After running an opsa-server restart command, information logged in the
/opt/HP/opsa/log/opsa-server. log file is removed. To view the files that retain this
information across restarts, see the log files located in the
/opt/HP/opsa/jboss/standalone/log directory. Look for log file names that begin with
server.log.
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Configuring Logger to Forward CEF Messages
to Operations Analytics

The feature being configured in this section is also known as the TCP Forwarding feature. After you
complete the configuration instructions in this section, the performance of the Operations Analytics All-
in-One for HP OneView Appliance significantly improves. You will also observe more real-time log
messages in the Operations Analytics All-in-One for HP OneView Appliance.

To configure Logger version 6.0 to forward CEF messages to the Operations Analytics All-in-One for
HP OneView Appliance, do the following from the Operations Analytics All-in-One for HP OneView
Appliance:

1.

Edit the following file:
/opt/HP/arcsight/current/arcsight/logger/config/logger/logger.defaults.properti
es

Change the following text:

from

# forwarder disallow localhost or not
forwarder.disallow.localhost=true

to

# forwarder disallow localhost or not
forwarder.disallow.localhost = false

Save your work.

Run the following commands to restart Logger: service arcsight_logger stop; sleep 30;
service arcsight_logger start
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5. From Logger, navigate to Configuration > Forwarders.

@ ArcSight Logger Summary Analyze w Dashboards Configuration ~ Systemn Admin Take me to... (%

Search
Filters
Search Group Filters

Saved Searches
Scheduled Searches/Alerts
Saved Search Files

Search Indexes
Search Options
Fieldsets
Default Fields
Custom Fields
Running Tasks

Lgakup Files

Data
Devices
Device Groups

Receivers
Source Types

FO rwarders

SNMP Destinations
Syslog Destinations
Certificates

Data Validation

6. Select the Forwarders tab; set the values following the example highlighted below; then click
Next:

Tawr tangey  LOGGET

Devices

Event Archives
Storage

Event Input
Ewvent Output
Alerts
Scheduled Tasks
Filters

Saved Search
Search
Configuration Backup
System Maintenance
License Information
Retrieve Logs
Content Management

HP Operations Analytics (2.31)

Summary Analyze Dashboards Reports

Configuration = System Admin
Forwarders || ESMDestinations | Certificates
Add Forwarder
Name | gpsaForwarder

Tvpe | 7P Forwarder

Filter Type l Unified Query
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7. Enter the values following the example highlighted below; then click Save:

Edit Forwarder

Mamé  OpsaFerwarder
QUENY | deviceVendor tm "ArcSight”

Advanded Search

Filters | Canfiguration - Corfiguration Changes (Urifisd)
Events - Evart Counts by Destination
Events - Event Counts by Scurce
Ewénts - High and Véry High Séventy Bvents (Urafied)
Firewall - Deny
Firewall = Drop
Firewall - Pesmrst
Intrugacn - Maboous Code (Unified)
Loging - &l Logins (Unified)
Logans - Fadied Logans o
Selecting a filter from the above list will replace the query with the filter definition

Filter by time rangs

Preserve Syslog Timestamp | fales i
Prigirve Ongnal Syfog Sender false -
IP/Hest  10,11.32.13

Port (4888

Conmection Retry Timeout =

Note:

= The query highlighted above is for Log Analytics (all fields). Make sure the query you
configure represents the collection you plan to configure.

= Change the highlighted IP address to thefully-qualified domain name of the Operations
AnalyticsCollector Appliance for the collection you plan to configure. You must use the
same value that is returned when you run the opsa-log-integration-config.sh -list
command .
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8. Enable the new configuration by clicking the highlighted area as follows:

10.

11.

12.

Filter Tygs

1P/ Hast Port
Bl unified Query 78 3 7

Filter Typs

1P He Part
B i Quary 16.7R58.155

fF X #+# N

Open the Operations Analytics console.
Edit the Arcsight Logger Instance for which you want to make this change.
Select the check TCP Forwarding checkbox.

Click OK to commit your changes.

Now that you completed the above steps, Logger forwards CEF messages to the Operations
Analytics All-in-One for HP OneView Appliance.

Configuring a Structured Log Collection

1.

HP Operations Analytics (2.31)

Using HP ArcSight Logger, define the search query to determine the data you want to collect. For
example, you might create the following search query in HP ArcSight Logger based on the
ArcSight's WebLogic SmartConnector:

agentType = "weblogic multi file" AND deviceVendor CONTAINS "Oracle"
| fields + startTime agentHostName sourceHostName name bytesIn
bytesOut deviceAction requestMethod requestUrl

A node list file contains details about the sources from which you plan to collect information. There
are sample nodelist files located inthe $OPSA HOME/conf/collection/sample directory.
Operations Analytics administrators can use these sample files to publish the node list file. The
sample node list file for the Structured Log collection is sample ArcSight
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node.properties.

Complete the following steps from the Operations Analytics All-in-One for HP OneView Appliance
for the Structured Log collection:

a. Copy the appropriate node list file from the SOPSA HOME/conf/collection/sample
directory to some location, such as /tmp/mynodelist.properties

Note: Select the template file pertaining to the type of collection you are configuring.

b. Editthe /tmp/mynodelist.properties file; add information according to what is written
in the sample file; then save your work.

HP ArcSight Logger: For example, using ArcSight's WebLogic SmartConnector example
shown earlier, you would specify the HP ArcSight Logger hostname and search query:
server.names = arcsightserver

##node properties for 'Arcsight'

arcsightserver.hostdnsname = <fully-qualified domain name of the
HP ArcSight Logger server>

arcsightserver.query = agentType = \"weblogic_multi_file\" AND deviceVendor
CONTAINS \"Oracle\" | fields + startTime agentHostName sourceHostName name
bytesin bytesOut deviceAction requestMethod requestUrl

Note: Although not shown in this example, always use deviceReceiptTime as afield
inthemynodelist.properties file.

Below are some helpful steps to help configure information in the bold font shown above:.
i. Confirm that HP ArcSight Logger is receiving the messages you expect.

ii. Verify that HP ArcSight Logger is processing the log messages into the correct fields.
For example, make sure that the agent severity and message fields are being
populated as expected. If HP ArcSight Logger is not parsing the messages into fields
properly, then you might need to correct the configuration for the connector, receiver, or
parser. See the HP ArcSight Logger Administrator's Guide for more information.

iii. Use the HP ArcSight Logger Analyze/Search facility to fine tune your row selection.
This corresponds to the configuration entries that reside before the bar character (|). HP
ArcSight Logger has a powerful parsing mechanism. You can tune HP ArcSight Logger
to choose the logs messages that interest you while ignoring those messages that are
not interesting. HP ArcSight Logger tuning is important, as many of the HP ArcSight
Logger receivers can receive logs from multiple sources.

iv. The configuration entries that reside before the bar character (|) that you add in this step
select the data (rows) to be collected.
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v. The text following the fields + keyword (after the bar character (|) that you add in this
step) sets the column names. After you are satisfied with the messages, work on the
fields. In HP ArcSight Logger, add | fields + F1 F2 F3to selectthe columns you
would like to send to Operations Analytics. You can do all this experimenting in HP

ArcSight Logger.

vi. Test the entire string from this step in the HP ArcSight Logger Analysis Search and
adjust the string for the desired results before continuing.

Note: You must remove the \ characters before testing the string in the HP
ArcSight Logger.

vii. When you are satisfied after working with these tuning tips, place the entire search
expressioninthe /tmp/mynodelist.properties file. You must backslash any

quotes you used.

c. Saveyourwork.

3. Run the following command from the Operations Analytics All-in-One for HP OneView Appliance if
you think there might be an existing structured log collection template you can use. Running this
command shows you the available predefined templates: SOPSA HOME/bin/opsa-
collection-config.sh -list -templates -username opsatenantadmin

4. Ifthereis no existing structured log collection template, do the following from the Operations
Analytics Server Appliance to create one:

a. Review the following HP ArcSight Logger collection templates:
/opt/HP/opsa/conf/collection/sample/config.templates/arcsight/1.0/a

pache/access/apache access.xml
/opt/HP/opsa/conf/collection/sample/config.templates/arcsight/1.0/1

og/structuredlog/arcsight collection.xml
/opt/HP/opsa/conf/collection/sample/config.templates/splunk/1.0/1log

/structuredlog/splunk collection.xml

b. Copy one of these templates to a temporary location; then edit the file to create the collection
template you need for your structured log collection. Suppose that, for this example, we call
this file mystructuredlog.xml.

Note: Considering the ArcSight's WeblLogic SmartConnector example shown earlier, you
might run the following command:

cpP
/opt/HP/opsa/conf/collection/sample/config.templates/arcsight/1.

0/log/structuredlog/arcsight collection.xml
/tmp/mystructuredlog.xml

c. Editthemystructuredlog.xml file:
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i. Considering the ArcSight's WebLogic SmartConnector example shown earlier, you might
change the domain, tags, group, and 1abel attributes forthe collectiongroup
elements as follows:
<?xml version="1.0" encoding="UTF-8"?>
<collectiongroup domain="weblogic"
tags="log,arcsight,weblogic,access" group="access" group
type="1log" label="WeblLogic Access Log">
<collector type="arcsight" wversion="5.5.0"
collectionintervalinseconds="300">
<sourcegroup name="default" granularityinseconds="300">
<source name="arcsightQuery" value="" type="query" />
</sourcegroup>
</collector>

Note: Although not shown in this example, if you see amapsto itemin your
collection template file, note its value, as it shows the associated column name in
HP ArcSight Logger. See the following table for more information.

Mapping a Column Name to Attribute Values (Examples)

Column Name Attribute Value
timestamp deviceReceiptTime
agentHostName agentHostName
sourceHostName sourceHostName
name name
bytesin bytesin
bytesOut bytesOut
deviceAction deviceAction
requestMethod requestMethod
requestUrl requestUrl

ii. Saveyourwork.

d. Copythemystructuredlog.xml fileto
/opt/HP/opsa/conf/collection/server/config.templates/<arcsight |
splunk>/<version from template file><domain from template
files>/<group from template files/mystructuredlog.xml

Considering the ArcSight's WebLogic SmartConnector example shown earlier, you might copy
themystructuredlog.xml file to a new weblogic folder:
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/opt/HP/opsa/conf/collection/server/config.templates/arcsight/1.0/w
eblogic/access

5. Run the following command from the Operations Analytics All-in-One for HP OneView Appliance
to create the collector configuration:
SOPSA HOME/bin/opsa-collection-config.sh -create -nodelist
/tmp/mynodelist.properties -collectorhost <fully-qualified-domain-
name of collector host> -source splunk|arcSight -domain <domain from
template files> -group <domain from template files> -username
opsatenantadmin

Considering the ArcSight's WebLogic SmartConnector example shown earlier, you would run the
following command:

SOPSA HOME/bin/opsa-collection-config.sh -create -nodelist
/tmp/mynodelist.properties -collectorhost <fully-qualified domain
name of the collector server> -source arcSight -domain weblogic -
group access -username opsatenantadmin

Note: The opsa-collection-config. sh script prompts you for the Tenant Admin
password for the username you use in the opsa-collection-config.sh command.

Look for a success message similar to the following:
Successfully created the collectorhost '<fully-qualified domain name

of the collector server>' configuration.

<fully-qualified domain name of the collector server> base directory:
/opt/HP/opsa/conf/collection/config.files/<fully-qualified domain
name of the collector server>/opsa
default/1.0/arcsight/1.0/weblogic/access

Successfully published the node list for this collector host.

6. Check the SOPSA HOME/log/collection config.logfile(oropsa.logfile)forerrors.
Correct these errors before continuing.

7. Run the following command from the Operations Analytics All-in-One for HP OneView Appliance
to validate the collection configuration you just created:

SOPSA HOME/bin/opsa-collection-config.sh -list
-allversions -collectorhosts -username opsatenantadmin

To verify a successful collection configuration creation, look for a message showing the expected
collector host name, tenant name, and tenant version. The message should also include the
source template details such as its version, domain, and group.

If you encounter any errors, look inthe /opt/HP/opsa/log/collection config.logfile
and review the logs carefully to understand and fix any errors.

8. Run the following command from the Operations Analytics All-in-One for HP OneView Appliance
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to publish this collection configuration:

SOPSA HOME/bin/opsa-collection-config.sh -publish -collectorhost
<fully-qualified domain name of the collector host> -username
opsatenantadmin -mode activel|passive

Note: If you followed the instructions in "Configuring a Structured Log Collection" on page 15,
you configured Logger to send CEF message to Operations Analytics and must use the -
mode passive optioninthis command. If you want Operations Analytics to actively request
log information (the original product behavior), use the -mode active option (the default
option) in this command.

For example, you can use a command similar to the following when publishing your collection
(notice the bold -mode passive option):

SOPSA HOME/bin/opsa-collection-config.sh -publish -collectorhost
<mycollector.company.com> —username opsatenantadmin-mode passive

See the opsa-collection-config.sh reference page (or the Linux manpage) for more
information.

The -pub11ish option uploads the collection configuration you created to the Operations
Analytics Collector Appliance. To verify that the collector configuration published successfully,
look for a message stating that the publish was successful and that a table was successfully
created.

Considering the ArcSight's WebLogic SmartConnector example shown earlier, you might see
something similar to the following:

Creating the collection database tables for the source:arcsight
domain:weblogic group:access and tenant:opsa default

Successfully created table using
/opt/HP/opsa/conf/collection/config. files/<fully-qualified domain name of
the collector host>/opsa_
default/1.0/arcsight/1.0/weblogic/access/metaData.xml for tenant
opsa_default

Registering the collection policy for the source:arcsight
domain:weblogic group:access and tenant:opsa default into the
database

Successfully registered collection policy for source
collector:arcsight tenant:opsa default- 1.0 Domain:weblogic
Group:access

Registering the list of sources for the source:arcsight
domain:weblogic group:access and tenant:opsa default into the
database

Successfully registered nodes for <fully-qualified domainname of the
collector host>-opsa default-weblogic-access in the Operations
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Analytics database

If you encounter any errors, look inthe /opt/HP/opsa/log/collection config.logfile
and review the logs carefully to understand and fix any errors.

9. Do the following to verify that the collection is working:

a. Open Arcsight Logger > Dashboards and notice the Receivers and Forwarders panes.
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b. Review the information shown in the Receivers pane to determine if Logger is receiving any
CEF messages from the smart connectors.

c. Review the information shown in the Forwarders pane to determine if Logger is forwarding the
CEF messages to Operations Analytics.

d. Do the following to verify that the Operations Analytics All-in-One for HP OneView Appliance
is listening for log messages:

Since the Operations Analytics All-in-One for HP OneView Appliance is listening on port 4888,
use your favorite command to check if the port is open. For example, you might run netstat
-a | grep 4888 to see if the Operations Analytics All-in-One for HP OneView Appliance is
successfully listening on port 4888.

10. Lookinthe /opt/HP/opsa/log/loader. log fileto see thatitis processing the contents of
the data being collected. Considering the weblogic example shown earlier, you might see
something similar to the following:

2014-02-15 15:16:53 DEBUG [pool-l1-thread-19] LoadDataCmd:512 -
archive file :/opt/HP/opsa/data/archive/opsa_
default/data~~arcsight~~weblogic~~access~~-2014-02-15 15-16-
49.782.csv

2014-02-15 15:16:53 DEBUG [collection data dir watcher]
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DatalLoader:240 - received notification
for/opt/HP/opsa/data/load/opsa_
default/data~~arcsight~~weblogic~~access~~-2014-02-15 15-16-
49.782.csv

Note: You can also test for success in several other ways:

Use a database management software tool to see if the table has been created, and that it is
being populated with the expected columns.

If you do not see the table, check to see that the csv data files are automatically created for
you on the Operations Analytics All-in-One for HP OneView Appliance. Look in the following
directories:

m SOPSA HOME/data/load/opsa default
m SOPSA HOME/data/archive/opsa default

When viewing these data files, if you see the columns you expect, but no rows, you might
need to correct the configuration for the connector, receiver, or parser.

11. Let the collection run for five minutes or longer. From the Operations Analytics console, view the
OpsA Meta Info dashboard. Look for the property group uid for the collection you just created
and published. Note: The property group uid consists of a combination of the source, domain,
and group parameters you used to create the collection. Considering the ArcSight's WebLogic
SmartConnector example shown earlier, you used a name of arcsight, a domain of weblogic,
and a group of access when creating the collection. The resulting property group uid would be
arcsight weblogic access

Note: THe Operations Analytics console does not display events, such as binary events, that
contains unprintable characters.

12. Create dashboards and query panes for the data you are now collecting. Follow the instructions
shown in the Dashboards and Query Panes section of the Operations Analytics Help for
information about creating dashboards and query panes.
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Considering the ArcSight's WebLogic SmartConnector example shown earlier, you might create a
dashboard similar to the following:
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13. Create AQL functions for the data you are now collecting. See the instructions shown in the Define
Analytic Query Language (AQL) Functions section of the Operations Analytics Help for
information about creating AQL functions.

Considering the weblogic example shown earlier, you might create the following AQL functions:
WebLogic Bytes Out

from i in (arcsight weblogic access) let analytic interval=between
($Sstarttime, S$endtime) let interval=S$Sinterval group by
i.agenthostname select moving avg(i.bytesout)

Access Requests by Source

from i in (arcsight weblogic access) let analytic interval=between
($starttime, S$endtime) let interval=S$Sinterval group by
i.sourcehostname select moving count (1)

WebLogic Top 5 Request URLs

from i in (arcsight weblogic access) let analytic interval=between
($starttime, $Sendtime) let interval=S$Sinterval select i.agenthostname,
i.requesturl, topN(aggregate count (i.requesturl), 5)

HTTP Return Codes

from i in (arcsight weblogic access) let analytic interval=between
($starttime, Sendtime) let interval=$interval group by i.deviceaction
select aggregate count (i.deviceaction)
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Configuring SSL for the HP Operations
Analytics All-in-One for HP OneView
Appliance

Note: Completing the steps shown in this section is not mandatory. If you prefer not to enable SSL
communication to the Operations Analytics All-in-One for HP OneView Appliance, skip this
section and continue with "Licensing the HP Operations Analytics All-in-One for HP OneView
Appliance " on page 27.

Use the information in this section to manage SSL on the Operations Analytics All-in-One for HP
OneView Appliance.

One-way SSL provides secure communication between the web browser and the Operations Analytics
All-in-One for HP OneView Appliance. During an SSL session creation, the server sends a digital
certificate (self-signed or CA signed) containing information about the server. This information, such as
domain, organization, and location, helps the web browser verify the server's identity. SSL is disabled
by default.

Configuring SSL with a Certificate Authority (CA)
Signed Certificate for the HP Operations Analytics
All-in-One for HP OneView Appliance

Complete the following steps to enable SSL communication to the Operations Analytics All-in-One for
HP OneView Appliance using a CA signed certificate:

1. Before enabling SSL to the Operations Analytics All-in-One for HP OneView Appliance, complete
this step to create a user in JBoss Management Realm. Do the following:
a. Runthe $OPSA HOME/jboss/bin/add-user. sh script.

b. Forthe first question, answer "a" - Management User (mgmt-users.properties), then follow
the instructions.

Note: You will need to provide the JBoss management realm credentials when enabling
SSL laterin these instructions.
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2. Runthe $OPSA HOME/bin/opsa-server-manager.sh script, and log on with super-admin
credentials. See the opsa-server-manager.sh reference page (or the Linux manpage), for more
information.

Note: The predefined super-admin login name is opsaadmin and the predefined super-admin
password is opsaadmin.

Note: The predefined super-admin login name is opsaadmin and the predefined super-admin
password is opsaadmin.

3. Select the Configure SSL option.

4. When using a CA signed public key of a server certificate obtained using a CSR generated from a
self-signed certificate, select the Import CA certificate to OPSA server keystore option to
import the certificate to the Appliance server keystore. The opsa-server-manager. sh script
prompts you for the certificate alias name and lists a set of used aliases.. Enter a unique alias
name that has not been used.

Note: The administrator can get a CA signed certificate by generating a Certificate Signing
Request file using the self-signed certificate stored in the OPSA keystore. Submit this
Certificate Signing Request to a Certificate Authority. To generate a Certificate Signing
Request from a self-signed certificate, select the Generate certificate signing request
option .The opsa-server-manager. sh script prompts you for the alias of the self-signed
certificate. Enter opsa_server from the list of aliases to generate Certificate Signing
Request for a self-signed certificate.

5. Optional: Select the Import trusted certificate to OPSA server truststore option to import
trusted certificates (if any). For example, you can add HP ArcSight Logger's server certificate to
the OPSA truststore file.

6. Select the Enable/Disable SSL option to enable SSL. You will need to enter the JBoss
Management Realm user and password you created in the first step.The opsa-server-
manager . sh script prompts you for the certificate alias to be used for SSL communication. Enter
one of the aliases from the listed aliases.

7. Select the Go back to main menu option; then select the Restart OPSA server option to restart
the Operations Analytics Server Appliance.

Note: Your configuration changes will not occur unless the server is restarted.

8. Operations Analytics users can access the Operations Analytics console using HTTP or HTTPS.
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Note: If a user attempts to use HTTP when HTTPS is configured, the user will automatically
be redirected using HTTPS.

9. Runthe service opsa-collector restart command to complete the configuration.

Configuring SSL with a Self-Signed Certificate for
the HP Operations Analytics All-in-One for
HP OneView Appliance

Complete the following steps to enable SSL communication to the Operations Analytics All-in-One for
HP OneView Appliance using a self-signed certificate:

1. Before enabling SSL to the Operations Analytics Server Appliance, complete this step to create a
user in JBoss Management Realm. Do the following:
a. Runthe $OPSA HOME/jboss/bin/add-user. sh script.

b. Forthe first question, answer "a" - Management User (mgmt-users.properties), then follow
the instructions.

Note: You will need to provide the JBoss management realm credentials when enabling
SSL later in these instructions.

2. Runthe $OPSA HOME/bin/opsa-server-manager.sh script, and log on with super-admin
credentials. See the opsa-server-manager.sh reference page (or the Linux manpage), for more
information.

Note: The predefined super-admin login name is opsaadmin and the predefined super-admin
password is opsaadmin.

Note: The predefined super-admin login name is opsaadmin and the predefined super-admin
password is opsaadmin.

3. Select the Configure SSL option.

4. Select the Generate self-signed certificate for OPSA server option to generate a self-signed
certificate and add the certificate to the Operations Analytics server keystore.

Note: The opsa-server-manager. sh script stores the self-signed certificate in the
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10.

keystore file with the opsa_server alias name.

Note: Set the self-signed certificate attributes, such as common name, country, and
validity by editingthe /opt/HP/opsa/conf/ssl/cert/opsa-self-signed-
cert.template file.

Optional: Select the Import trusted certificate to OPSA server truststore option to import
trusted certificates (if any). For example, you can add HP ArcSight Logger's server certificate to
the OPSA truststore file.

Select the Enable/Disable SSL option to enable SSL. You will need to enter the JBoss
Management Realm user and password you created in the first step.The opsa-server-
manager . sh script prompts you for the certificate alias to be used for SSL communication. Enter
one of the aliases from the listed aliases.

Select the Enable/Disable SSL option to enable SSL. The opsa-server-manager. sh script
prompts you for the certificate alias to be used for SSL communication. Enter opsa_server.

Note: opsa_server is one of the aliases shown by the script.

Select the Go back to main menu option; then select the Restart OPSA server option to restart
theOperations Analytics Server Appliance..

Note: Your configuration changes will not occur unless the server is restarted.

Operations Analytics users can access the Operations Analytics console using HTTP or HTTPS.

Note: If auserattempts to use HTTP when HTTPS is configured, the user will automatically
be redirected using HTTPS.

Run the service opsa-collector restart command to complete the configuration.

Licensing the HP Operations Analytics All-in-
One for HP OneView Appliance

The Operations Analytics All-in-One for HP OneView Appliance comes with an Implicit node pack
(Instant On) license that is valid for 60 days.To view the existing Appliance license, navigate to Help
> About> License from the Operations Analytics console. See "Licensing HP OneView" on page 30
for more information.

Review the following environment considerations:
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Note: The following items are environment considerations, and are independent from licensing.

o Considering the HP OneView customer, each HP OneView application server manages 640 HP
servers + X number of other objects ( interconnect, devices, power devices, and other objects) for
an approximate total of 1024 objects.

« Ifan HP OneView customer environment contains more than 1024 objects to be managed, they will
need more than one HP OneView application server.

« One Operations Analytics for HP OneView deployment integrates with a single HP OneView
application server.

« An Operations Analytics for HP OneView deployment could be one of the following, depending on
the above environment considerations:

= A single Operations Analytics for HP OneView Appliance as explained in this manual.
= A distributed Operations Analytics deployment, including Vertica, Logger, an Operations

Analytics Server Appliance, and an Operations Analytics Corrector Appliance. See the HP
Operations Analytics Installation Guide for more information.

Testing the HP Operations Analytics All-in-
One for HP OneView Appliance

Complete the following steps to test the Operations Analytics All-in-One for HP OneView Appliance.

Note: You have not yet enabled the Operations Analytics - HP OneView integration. This step only
tests some basic Operations Analytics functionality.

1. Set up the Operations Analytics All-in-One for HP OneView Appliance.
2. Take a snapshot of the Operations Analytics All-in-One for HP OneView Appliance.
3. Using SSH, log on to the Operations Analytics All-in-One for HP OneView Appliance.

4. When prompted, change the Operations Analytics All-in-One for HP OneView Appliance
password, and note the new password.

Note: To log on to the Operations Analytics All-in-One for HP OneView Appliance for the first
time, use the following authentication credentials:

User: opsa

Password: opsa
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The opsa user has the privileges to switch to the root user, if necessary. You need to provide
the root password (initially set to iso*help) to switch to the root user.

5. Do the following to check the status of the Operations Analytics All-in-One for HP OneView
Appliance:

a. Run the following command: /opt/HP/opsa/bin/opsa-server status
Look for the following message: opsa-server is running

b. Run the following command: /opt/HP/opsa/bin/opsa-collector status
Look for the following message: opsa-collector is running

6. Do the following to log on to the Operations Analytics console and check the dashboard.
a. Point your browser to http://hostname:8080/opsa

b. Logonusing opsa as a username and opsa as the password. You should see the Welcome
to Operations Analytics page.

c. Click the Start Using Application button. You should see the following dashboards:
o OpsA Health: This dashboard shows system health information for Operations Analytics.

Note: You might need to wait 20 minutes or more for the HP Operations Agent to
publish its collected data.

o OA Environment Overview: This dashboard shows the nodes having the top CPU, disk,
memory, and network utilization. Although there is only one node in the database, you will
see more data after you add more collection sources to Operations Analytics.

o OpsA Meta Info: This dashboard shows the list of tables and tags configured by default.
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Chapter 3: Enabling the HP Operations
Analytics- HP OneView Integration

Operations Analytics's integration with HP OneView provides IT professionals a summary of the
converged infrastructure devices being managed by HP OneView. With this integration, Operations
Analytics becomes the troubleshooting, analytic, and capacity planning arm of HP OneView. The
Operations Analytics-HP OneView integration provides summary information for the infrastructure
devices as well as doing analytics on the management data from HP OneView, including logs, metrics,
alerts, and inventory data.

Note: See http://www.hp.com/go/opsanalytics or http://www.hp.com/go/oneview for more
information.

Supported HP OneView Versions
To view a list of the HP OneView versions supported by Operations Analytics, do the following:
1. Point your browser to Software Solutions Now.
2. Click the Integrations link.
3. Scroll to the Operations Analytics integrations; then select the Operations Analytics pull-down.
4. Select the integration with HP OneView; then view the support matrix table to see the supported

versions.

Note: Operations Analytics only supports an integration with HP OneView if HP OneView is
installed on a Linux Operating System.

Licensing HP OneView

Operations Analytics comes with an Implicit node pack (Instant On) license that is valid for 60 days.
You must purchase and install one of the following permanent licenses before the Instant On license
expires:

« Operations Analytics HP OneView node permanent license: The Operations Analytics HP
OneView node license enables the Operations Analytics HP OneView integration collections and
features only.

« Full Operations Analytics license (in 50 node pack) permanent license: This license enables
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the full Operations Analytics collections and full features.

Note: The Operations Analytics All-in-One for HP OneView Appliance does not support the
configuration of other types of collections. Only Operations Analytics All-in-One for HP
OneView Appliance collections that are configured as explained in "About Data Collections for
the HP Operations Analytics - HP OneView Integration" on page 37 are supported.

From the Operations Analytics console, navigate to Help > About, then click the License tab to view
the type of license you have.

Toinstall the Operations Analytics HP OneView node permanent license, do the following:

1.

2.

Copy the license.dat file issued by HP licensing service to the /tmp directory.

Run the following command as the opsa user to install the license:
$OPSA_HOME/bin/opsa-license-manager.sh -add /tmp/license.dat

Run the following command as the opsa user and make sure the license you just installed is listed:
$OPSA_HOME/bin/opsa-license-manager.sh -list

To install the 50 node pack permanent license, do the following:

1.

2.

Copy the license.dat file issued by HP licensing service to the /tmp directory.

Run the following command as the opsa user to install the license:
$OPSA_HOME/bin/opsa-license-manager.sh -add /tmp/license.dat

Run the following command as the opsa user and make sure the license you just installed is listed:
$OPSA_HOME/bin/opsa-license-manager.sh -list

See the opsa-license-manager.sh reference page (or the Linux manpage) for more information.

Note: After installing a new license, from the Operations Analytics console, navigate to Help
> About, then click the License tab to view the type of license you now have.

Configuring the HP Operations Analytics - HP
OneView Integration

The information in this section explains how to configure the Operations Analytics - HP OneView
integration.

Note: The Operations Analytics All-in-One for HP OneView Appliance and the HP OneView Server
must each be able to resolve each other's fully-qualified domain names for the Operations
Analytics - HP OneView integration to function correctly.
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Note: Important: You must complete the licensing work in "Licensing HP OneView" on page 30
before completing the instructions in this section.

Note: When completing the following steps, if you receive a message that the HP OneView
Integration failed, click Integrate to try configuring the integration again.

To configure the Operations Analytics - HP OneView integration, log on to Operations Analytics as a
tenant administrator, then do the following:

Note: You can enable the Operations Analytics - HP OneView integration as the opsatenantadmin
tenant administrator or as a tenant administrator for a tenant you created. You can only configure
this integration using one tenant (this integration does not support multiple tenants).

« Ifthis is the first time you have logged on as a tenant administrator, do the following:
a. The Operations Analytics Welcome Page appears.
b. Click the Start Using Application button and the HP OneView settings dialog box opens.

c. Enterthe HP OneView setting information; then click Integrate.

Note: You will be prompted for the fully-qualified domain name of the HP OneView server
(orits IP address), the user name to use for the HP OneView server, and the password for
the user name you provide.

Note: The Frequency parameter adjusts how often Operations Analytics collects metric
data from HP OneView. Adjust this parameter carefully to avoid creating system
resource issues. If you leave the field for this parameter blank, Operations Analytics a
default value of 3600 seconds (one hour). If you want to see faster results, you might set
this value to 300 seconds (5 minutes).

Note: If HP OneView is configured with Active Directory, enter the User Principal Name in
the User name field.
Example: <username>@<domain>.com.

Note: You can watch the integration messages as the configuration progresses. For
example, you should see messages related to configuring certificates, syslog forwarding,
metrics frequency, and security credentials.

« If you have logged on as a tenant administrator before on this Operations Analytics server, do the
following:
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a. Select © (OneView Settings) from the configuration menu. This opens the OneView
Settings dialog box.

b. Enterthe HP OneView setting information; then click Integrate.

All of the integration steps automatically happen after entering the HP OneView setting
information.

Note: You will be prompted for the fully-qualified domain name of the HP OneView server
(orits IP address), the user name to use for the HP OneView server, and the password for
the user name you provide.

Note: The Frequency parameter adjusts how often Operations Analytics collects metric
data from HP OneView. Adjust this parameter carefully to avoid creating system
resource issues. If you leave the field for this parameter blank, Operations Analytics a
default value of 3600 seconds (one hour). If you want to see faster results, you might set
this value to 300 seconds (5 minutes).

Note: If HP OneView is configured with Active Directory, enter the User Principal Name in
the User name field.
Example:<username>@<domain>.com.

Note: You can watch the integration messages as the configuration progresses. For
example, you should see messages related to configuring certificates, syslog forwarding,
metrics frequency, and security credentials.

Note: It can take up to one hour for HP OneView to forward a complete set of data to
Operations Analytics.

If you encounter problems during setup, see "Troubleshooting the HP Operations Analytics- HP
OneView Integration" on the next page for more information.

After you finish integrating Operations Analytics with HP OneView you can view summary information
for the infrastructure servers and analytics using the management data from HP OneView (log, metric,
alerts, and inventory data).

HP Operations Analytics (2.31) Page 33 of 73



HP Operations Analytics for HP OneView Installation, Integration, and Upgrade Guide
Chapter 3: Enabling the HP Operations Analytics- HP OneView Integration

Troubleshooting the HP Operations Analytics-
HP OneView Integration

Use the following information to test and troubleshoot any issues with the Operations Analytics - HP
OneView Integration.

Note: It is mandatory that the Operations Analytics All-in-One for HP OneView Appliance have a
valid fully-qualified domain name for this integration to function successfully.

Question: When enabling the Operations Analytics - HP OneView integration, how might | avoid
potential authentication problems?

Answer: The role for the HP OneView user should have infrastructure administrator privileges.

Note: Use an existing user account or create a new user account to prevent potential
authentication problems. For either approach, the user must have the infrastructure administrator
role.

1. Logon tothe HP OneView console.
2. Navigate to Settings > users and groups
3. Do only one of the following from the HP OneView console:

m Choose an existing infrastructure administrator for the integration like the administrator or
opsa user shown below.
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Question: After enabling the Operations Analytics - HP OneView integration, how do | make sure that
the syslog forwarding is functioning correctly?

Answer: To verify that the syslog forwarding is functioning correctly for the HP Integrated Lights-Out
(iLO), do the following:

1. Logontothe HP OneView server.
2. Select Servers > Server Hardware from the HP OneView console.

3. Locate the Hardware heading, scroll to the iLO row, then click the associated |IP address to log on
to the Integrated Lights-Out console.

4. Select Administration > Management.
5. Select the Remote Syslog tab.

6. Check that the IP address entry in the remote Syslog Server field matches the IP address of the
Operations Analytics server.

Question: After enabling the Operations Analytics - HP OneView integration, how do | make sure that
the metrics are functioning correctly?

Answer: You should see metrics within one hour or less. Check any of the HP OneView dashboards in
Operations Analytics and verify that the metric data is appearing.

Note: You can adjust the frequency of the metrics by adjusting the Frequency option in the HP
OneView settings.

Question: After enabling the Operations Analytics - HP OneView integration, how do | make sure that
the syslog forwarding is functioning correctly for Enclosures?

Answer: To verify that the syslog forwarding is functioning correctly for Enclosures, do the following:
1. Log on to the HP Blade System Onboard Administrator (OA)
2. Select Active Onboard Administrator.
3. Click System Log.
4. Click the Log Option tab.

5. Check that the IP address entry in the remote Syslog Server field matches the IP address of the
Operations Analytics server.

Note: If you use a hostname instead of an IP Address for these fields, and the network uses
statically assigned IP addresses, you must configure a DNS server in the EBIPA settings.
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Question: When setting up the integration, you see one or more integration error messages. For
example, these messages might involve configuring certificates, syslog forwarding, metrics frequency,
or security credentials. What should you do?

Answer: Follow any remedies included in the displayed error messages. If there are no displayed
remedies, do the following:

1. Log on to Operations Analytics as a tenant administrator user.
2. Select Settings > OneView Settings

3. Configure the Operations Analytics- HP OneView integration and see if this action corrects the
problem.

Note: To remedy any of the problems you might encounter, complete the above steps before
doing any further troubleshooting or opening a support call.

Question: When setting up the integration, where can | find relevant data?

Answer: Look for the following files in the/opt/HP/opsa/log directory:
e collection_config.log (usually the most informative)
e collection-manager.log
e collection-setup.log

Question: When viewing the OneView Interconnect 360 dashboard, you do not see any
interconnects data. What should you do?

Answer: Do the following from the OneView console:
1. Verify that your LIG configuration matches your actual hardware.

2. If there s still no interconnect data, refresh the enclosures.

About Data Collections for the HP Operations
Analytics - HP OneView Integration

The following collections begin collecting data automatically after you configure the Operations
Analytics - HP OneView integration:

HP OneView Data Collections

Collection Name Source Domain Group
HP OneView Alerts oneview rabbitmq alerts
HP OneView Interconnect Metrics oneview rest Interconnect_metrics
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HP OneView Data Collections, continued

Collection Name Source Domain Group

HP OneView Inventory oneview rest inventory

HP OneView Inventory Changes oneview rabbitmq inventory-changes
HP OneView Metrics oneview rabbitmq metrics

HP OneView Syslog arcsight OneView OneViewSyslogs
HP OneView Trees oneview rest topologytree

Note: The property group uid for each preconfigured Operations Analytics All-in-One for HP
OneView Appliance collection consists of a combination of the source, domain, and group
parameters used to create the collection. For example, for the Operations Analytics All-in-One for
HP OneView Appliance Inventory collection, it uses a domain of rest and a group of inventory
when creating the collection. The resulting property group uid is oneview_rest_inventory.

Note: The HP OneView Syslog collection shown in "HP OneView Data Collections" on the
previous page includes an installed syslog daemon and uses port UDP 514.

Using the HP Operations Analytics -
HP OneView Integration

After you finish configuring the Operations Analytics - HP OneView integration, the Operations
Analytics - HP OneView data collections begin adding data to the dashboards included with the
Operations Analytics- HP OneView integration. See Operations Analytics Integration with

HP OneView in the Operations Analytics Help for more information about the benefits of this
integration.

HP Operations Analytics - HP OneView
Integration Security Hardening

« Authentication: The Operations Analytics All-in-One for HP OneView Appliance Inventory and
Tree collections use the Rest API. This collection requires user names and passwords. The
Operations Analytics All-in-One for HP OneView Appliance Inventory Changes, Metrics and Alerts
collections require the certificates that are stored in keystore and truststore files. These two stores
require password authentication.

« Key Management: These keys are stored in the /opt/HP/opsa/conf/ssl/opsa_defaults
directories.
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« Encryption: Operations Analytics's Inventory Changes, Metrics and Alerts collections require the
passwords for the keystore and truststore used by the HP OneView server. These passwords are
encrypted.

« User Permissions: To configure the Operations Analytics - HP OneView integration, log on to
Operations Analytics as a tenant administrator. See the Operations Analytics Configuration Guide
for information about configuring the Operations Analytics users.

« Certificates: After you click the Integrate button, Operations Analytics sends the HP OneView
host, user name, and password to the HP OneView server. The HP OneView server returns the
certificate data in forms that Operations Analytics places in the /opt/HP/opsa/conf/ssl/opsa_
defaults directories on the Operations Analytics Server. After the Operations Analytics All-in-One
for HP OneView Appliance collections are published (this happens automatically during the
integration setup), Operations Analytics moves these files to the Operations Analytics Collector
host.

« Data being Collected: The Operations Analytics All-in-One for HP OneView Appliance collections
obtain data from HP OneView, which includes logs, metrics, HP OneView alerts, and topology
data.

Note: logs originate from the devices that HP OneView currently manages (they come from
HP OneView-managed servers and enclosures). These logs are really syslogs.
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Chapter 4: Expanding to a Distributed
Operations Analytics

After installing, configuring, and using the features of the Operations Analytics All-in-One for HP
OneView Appliance version 2.31, you might decide to expand it into a distributed version of Operations
Analytics version 2.31.

Before starting through these steps, run the following command to list the existing collections:

/opt/HP/opsa/bin/opsa-collection-config.sh -list -collectorhosts -username
<opsaTenantAdminUser> -password <opsaTenantAdminPasswd>

You will need the details for these collections to register them on the new Operations Analytics Server
Appliance as discussed towards the end of these steps.

Task 1: Unregister all of the Collections and
the Collector

You must unregister all of the Operations Analytics All-in-One for HP OneView Appliance collections
as well as the predefined Operations Analytics collections from the Operations Analytics All-in-One for
HP OneView Appliance. You must unregisterthe registration for the Collector as well.

Note: You will re-register all of the mentioned items during "Task 7: Adding a New Operations
Analytics Server" on page 52

To complete the mentioned unregister work, do the following:

1. Run the following command to unregister the Operations Analytics All-in-One for HP OneView
Appliance collections: /opt/HP/opsa/support/publishOneViewCollections.sh UNREGISTER
<collector fully-qualified domain name> <opsaTenantAdminUser>
<opsaTenantAdminPasswd>

Note: publishOneViewCollections.sh is an unsupported script used for troubleshooting and
support purposes.

2. Run the following commands to unregister the other collections:
/opt/HP/opsa/bin/opsa-collection-config.sh -unregister -collectorhost

<collectorhost name or IP address> -username <opsaTenantAdminUser> -password
<opsaTenantAdminPasswd> -source arcsight -domain log -group stream
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/opt/HP/opsa/bin/oopsa-collection-config.sh -unregister -collectorhost
<collectorhost name or IP address> -username <opsaTenantAdminUser> -password
<opsaTenantAdminPasswd> -source oa -domain sysperf -group global

3. Run the following command to unregister the Operations Analytics All-in-One for HP OneView
Appliance collector: /opt/HP/opsa/bin/opsa-collection-config.sh -unregister -
collectorhost <fully-qualified domain name of collector host> -username
<opsaTenantAdminUser> -password <opsaTenantAdminPasswd>

4. Run the following command to unregister the Operations Analytics All-in-One for HP OneView
Appliance Logger:

/opt/HP/opsa/bin/opsa-log-integration-config.sh -loginUser
<opsaTenantAdminUser> -loginPassword <opsatenantAdminPasswd> -delete -host
<fully-qualified domain name of Loggerhost> -collectorHost <fully-qualified
domain name of Collector host> -loggerType arcsight -base64Decode true

Task 2: Expanding the HP Operations
Analytics All-in-One for HP OneView
Appliance

Carefully complete the following steps to expand your Operations Analytics All-in-One for HP OneView
Appliance into a distributed version that can use the integration with HP OneView:

To check if you have the Operations Analytics All-in-One for HP OneView Appliance configured for
DHCP, and, if necessary, change the configuration to support a static IP address, do the following:

1. Asroot, edit the /etc/sysconfig/network-scripts/ifcfg-etho file on the Operations
Analytics Server Appliance.

2. Locate the line beginning with BOOTPROTO. If the value on that line is none, then the Operations
Analytics All-in-One for HP OneView Appliance is configured for static IP and you do not need to
take any further action. Close the /etc/sysconfig/network-scripts/ifcfg-etho file on the
Operations Analytics Server Appliance and do not complete the remaining steps.

3. Locate the line beginning with BOOTPROTO. If the value on that line is something like dhcp, then
the Operations Analytics All-in-One for HP OneView Appliance is configured for DHCP, and you
must complete the remaining steps in this section.

Note: When using DHCP, Operations Analytics uses a standard ifcfg-etho file
configuration recommended by CentOS. If your network configuration is different from the
standard described by CentOs, Operations Analytics might not be able to get an IP address
from DHCP or access the VM using the hostname or fully-qualified domain name. See
Configuring a DCHP Client in the Red Hat Enterprise Linux Deployment Guide for more
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information.

4. Locate the line beginning with BOOTPROTO. If the value on that line is something like dhcp, then the
node is configured for DHCP and you must complete the remaining steps.

Note: Run the ifconfig -a command if you want to know the server's current IP address
and other network information.

5. From a command prompt on the Operations Analytics All-in-One for HP OneView Appliance, shut
down Operations Analytics (if it is running) by running, as the opsa user, the following commands:

Note: In some environments, the DHCP node might only be accessible (routable) using the
web and the vSphere console. In that case, use the vSphere console to sequentially run the
commands shown below.

a. /opt/HP/opsa/bin/opsa-process-manager.sh stop
b. /opt/HP/opsa/bin/opsa-server stop

c. /opt/HP/opsa/bin/opsa-collector stop

d. /opt/HP/opsa/bin/opsa-loader stop

6. As theroot user, edit the /etc/sysconfig/network-scripts/ifcfg-ethefile.

Note: When using DHCP, Operations Analytics uses a standard ifcfg-etho file
configuration recommended by CentOS. If your network configuration is different from the
standard described by CentOs, Operations Analytics might not be able to get an IP address
from DHCP or access the VM using the hostname or fully-qualified domain name. See
Configuring a DCHP Client in the Red Hat Enterprise Linux Deployment Guide for more
information.

Note: Make the changes for the steps in this task only after consulting your network
administrator:

7. Make the remaining changes shown below only after consulting your network administrator:
BOOTPROTO=none
IPADDR=<your new IPv4 IP address>

8. Set the NETMASK, GATEWAY, and BROADCAST parameters appropriately. After you finish, it should
look something like the following:
DEVICE=etho
BOOTPROTO=none
ONBOOT=yes
TYPE=Ethernet
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10.

IPV6INIT=no

IPADDR=<your new IPv4 IP address>
NETMASK=<your netmask>

GATEWAY=<IP Address of the default gateway>
BROADCAST=<broadcast IP Address>

Note: When a system is using DHCP, the IP address, which is provided automatically, is not
registered in DNS. However, static IP addresses are frequently registered in DNS. If that is
the case, edit the /etc/sysconfig/network file and revise the hostname value.

After you save all of your changes, your remote connection to the Operations Analytics All-in-One
for HP OneView Appliance terminates because the old IP address no longer exists. Log on to the
Operations Analytics All-in-One for HP OneView Appliance using the vSphere client, bring up the
console, then run the following commands:

a. /sbin/service network restart
b. /etc/sysconfig/network-scripts/ifup ethe

After the commands complete in the previous step, log on to the Operations Analytics All-in-One
for HP OneView Appliance remotely using the new IP address for the Operations Analytics All-in-
One for HP OneView Appliance.

Task 3: Testing and Configuring the Network

Complete the following to make sure the network is configured correctly for the Operations Analytics
All-in-One for HP OneView Appliance:

1.

Runthe nslookup <Operations Analytics All-in-One for HP OneView Appliance IP
address> command and the hostname command on the Operations Analytics All-in-One for HP
OneView Appliance.

Compare the two host names from the previous step. If they are not identical, do the following:
a. Verify that the correct server names exist in the resolv. conf file.

b. Verify that the correct host name resides in the following files:
/etc/sysconfig/network
/etc/hostname

If necessary, run the following command to force any changes you made to take effect:
service network restart

Repeat the steps in this section until the network is configured correctly.

HP Operations Analytics (2.31) Page 43 of 73



HP Operations Analytics for HP OneView Installation, Integration, and Upgrade Guide
Chapter 4: Expanding to a Distributed Operations Analytics

Task 4: Expanding Vertica

The information in this section explains how to install three new Vertica nodes on new VMs or servers.
When combined with the Vertica application included with the Operations Analytics All-in-One for HP
OneView Appliance that you currently have installed, it totals four Vertica nodes in the Vertica Cluster.
The Vertica license included on the Operations Analytics All-in-One for HP OneView Appliance only
supports three nodes. Before continuing with this expansion, you must obtain a Vertica license from
Vertica and install it on the Operations Analytics All-in-One for HP OneView Appliance.

Note: One way to obtain a fourth Vertica license is to purchase an Operations Analytics production
license. See Obtaining Licenses in the Operations Analytics Installation Guide for more
information about obtaining and installing Operations Analytics licenses.

After obtaining a fourth Vertica license, carefully complete the following steps to expand Vertica on
your Operations Analytics All-in-One for HP OneView Appliance into a distributed version.

1. Rename /opt/HP/opsa/cont/jmxNotHardened.tx to
/opt/HP/opsa/conf/jmxNotHardened. txt

Note: In this step you are changing the . tx extension to . txt.
2. Run the following command to restart the Operations Analytics server: opsa-server restart

Note: After running an opsa-server restart command, information logged in the
/opt/HP/opsa/log/opsa-server. log file is removed. To view the files that retain this
information across restarts, see the log files located in the
/opt/HP/opsa/jboss/standalone/log directory. Look for log file names that begin with
server.log.

3. Navigate to the following URL: http://<IP Address of the Operations Analytics AlO
VM>:8081/mbean?objectname=0PSA-Infrastructure%3Aservice%3DDeployment

4. Provide the default user name (opsaadmin) and password ( opsaadmin)

5. Run the removeDeploymentForHost method by entering the <IP Address of the Operations
Analytics AIO VM> and then entering yes in the appropriate box.

6. Logontothe Vertica server as an opsa user.
7. Run the following command to become the root user: su -

8. Run the following command to become the Linux dbadmin user: su - dbadmin
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Note: Regardless of your use of DHCP or Static IP addresses, Vertica is using
local.host forits address. This inhibits Vertica's ability to join a cluster. To remedy this,
you must reconfigure Vertica on the Operations Analytics All-in-One for HP OneView
Appliance to use the Operations Analytics All-in-One for HP OneView Appliance's new or
existing static IP address.

9. Runthe /opt/vertica/bin/admintools tool.
10. Complete the following steps to shut down the Vertica database:
a. From the Main Menu, select Advanced Tools.
b. Select option 2: Stop Vertica on Host.
c. From the Select Host(s) window, select the host box; then click OK.
d. When prompted about whether you are sure you want to stop Vertica, click yes.

e. From the Main Menu, select View Database Cluster State to make sure that Vertica is shut
down.

Note: If you are haing problems run /opt/HP/opsa/bin/opsa stop as root

11. Complete the following steps to convert Vertica from having a loopback address to having a static
IP address:

a. Contact Vertica or Operations Analytics support and download the latest re_ip cluster-
2.1.py script onto the Operations Analytics All-in-One for HP OneView Appliance. Make sure
the re_ip cluster-2.1.py script has permissions to be run by the Linux dbadmin user.

b. Logon as the root user.

¢. Shut down Vertica and Operations Analytics by running the following
command: /opt/HP/opsa/bin/opsa stop

d. As root, determine your IP address and broadcast address by running the following
command: /sbin/ifconfig

e. Logon as the Linux dbadmin user.

f. Runthe following command: re_ip_cluster-2.1.py -c /opt/vertica/opsa_
data/opsadb/v_opsadb_node@ool_ catalog -s
Running this command creates a re_ip_batch.ini file in the same directory from which you
ran the command. Write down the location of this file.

g. Editthe re_ip batch.ini file
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12.

13.

h. Replace the loopback addresses and broadcast address with the IP address and broadcast
address returned by the /sbin/ifconfig command you ran earlier.

i. Save yourwork.

j- Runthe following command: re_ip cluster-2.1.py -c /opt/vertica/opsa_
data/opsadb/v_opsadb_node@o0l _catalog -b <path to the re_ip batch.ini file>

k. When prompted, press Enter.

Reserve IP addresses for three or four additional Vertica systems. Create new virtual appliances
or set up hardware using these new IP addresses.

Note: Before adding any new Vertica nodes to the existing cluster on the Operations
Analytics All-in-One for HP OneView Appliance, it is recommended that you back up the
Operations Analytics All-in-One for HP OneView Appliance database. See the Backing Up
and Restoring section of the Vertica Administrator's Guide for more information.

Run the following commands on the Operations Analytics All-in-One for HP OneView Appliance
for each Vertica server to test if ssh is functioning (without requiring passwords):

Run as aroot user:

ssh -X root@<Vertica IP Address>

ssh -X dbadmin@<Vertica IP Address>

Run as a Linux dbadmin user:
ssh -X dbadmin@<Vertica IP Address>

If you find that passwords are required, run the following commands on each new Vertica server to
set up ssh to not require passwords. Retest your changes using the ssh command shown in the
previous paragraph after you finish:

ssh-copy-id -i root@<Vertica IP Address>

ssh-copy-id -i dbadmin@<Vertica IP Address>

Note: Using the commands shown in this step as a guide, confirm that ssh is functioning
(without requiring passwords) from each Vertica server to the Operations Analytics All-in-One
for HP OneView Appliance and from each Vertica server to all other Vertica servers.

Note: If the ssh-copy-id script is not available on a server, look for a copy of it in the
/opt/HP/opsa/scripts directory on the Operations Analytics All-in-One for HP OneView
Appliance; then do the following:
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a. As the root user, copy the ssh-copy-id script to the /tmp directory.

b. As the root user, run the following command to change the script permissions: chmod
555 ssh-copy-id

Note: After completing this step, if you find that ssh does not function (without requiring
passwords), here are a few possible causes:

m Edit the /etc/sshd_config file and make the following changes, if needed.
i. Find PermitRootLogin and make sure it is set as follows: PermitRootLogin Yes
ii. Find DenyUsers and make sure it does not have dbadmin in the list.
iii. Save your changes.
iv. Run the following command as the root user: service sshd restart
m The /home directory must be searchable with mod 755 permissions.

m The /home/dbadmin directory must be owned by the Vertica dbadmin user and have mod
700 permissions.

m |fyouseeaNo identities found message, you need to run the ssh-keygen command
to create a public key for the ssh-copy-id command to overwrite.

14. Turn off the firewall on the Operations Analytics All-in-One for HP OneView Appliance and all for
the new ssh is functioning (without requiring passwords) Vertica servers by running the following
command: service iptables stop

Note: Tumn the firewalls on for the Operations Analytics All-in-One for HP OneView Appliance
and all for the new Vertica servers after completing this task by running the following
command:

service iptables start

15. From a command prompt on the Operations Analytics All-in-One for HP OneView Appliance, run
the following command (as root) :
/opt/vertica/sbin/update_vertica -A <IP Address of VM1>,<IP Address of
VM2>,<IP Address of VM3> -r <rpm_package>

Note: The update_vertica command assumes that Vertica is not installed on any of the
destination systems. Before running this command, make sure that the destination systems
do not already have Vertica installed.
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Note: When you run the update_vertica command in this step, replace the < IP Address of
VM 1> with the IP address of the Operations Analytics All-in-One for HP OneView Appliance.
Replace the remaining VM IP addresses in the command with a comma separated list of all of
the external Vertica servers you are adding.

16. Complete the following steps on each new virtual appliance to install the R Language Pack from
Vertica:

Note: Run any commands shown in this list as the root user.

a. Goto My software updates (use your HP Passport credentials) and download HP Operations
Analytics 2.31 Vertica Integration.zip.

b. Extract the contents of the HP Operations Analytics 2.31 Vertica Integration.zip
file to a temporary location.

c. Copy the files from the MASS and vertica folders located in the local directory to which you
downloaded and extracted the HP Operations Analytics 2.31 Vertica
Integration.zip file to the /home directory:

d. Run the following command to create the link to the R-Vertica function: 1n -s
/home/dbadmin /home vertica

e. Run the following command to set the correct folder permissions: chmod 770 /home
vertica

f. Run the following command to install a group package to enable the MASS statistics Library
to compile:

Note: This command will not work without an Internet connection. Make sure you have
an Internet connection before running this command.

yum groupinstall 'Development tools'

Tip: For an alternative approach to installing development tools offline, see Unix & Linux
Stack Exchange.

g. Run the following command to install the compat-1ibgfortran package:
rpm -Uvh compat-libgfortran-41-4.1.2-39.el6.x86_64.rpm

h. Install all 3 vertica-R-lang packages located in the vertica directory in incremental order as
shown in the following example:
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rpm -Uvh vertica-R-lang-7.1.1-0.x86_64.RHELS.rpm
rpm -Uvh vertica-R-lang-7.1.1-3.x86_64.RHELS.rpm
rpm -Uvh vertica-R-lang-7.1.1-5.x86_64.RHELS.rpm
i. Verification: To verify the R Language Pack installation, do the following:
i. Runthe following command: a. rpm -qa | grep -i vertica-R

ii. If yousee amessage similar to the following, the installation was successful:
vertica-R-lang-<VERSION>

j. Complete the following steps to install the MASS package:
i. Run the following command to set the correct permissions: chmod 770 MASS_7.3-
23.tar.gz

ii. Copy the /home/MASS_7.3-23.tar.gzfileto /root/MASS 7.3-23.tar.gz

iii. Run the following command: /opt/vertica/R/bin/R CMD INSTALL /root/MASS_7.3-
23.tar.gz

17. From the Operations Analytics All-in-One for HP OneView Appliance, do the following to add the
new Vertica nodes to the database:
a. Run /opt/vertica/bin/admintools as the Linux dbadmin user.

b. Start the database.

c. From the Main Menu, select Advanced Tools, select Cluster Management, then select
Add Host(s).

d. Select the database (opsadb) to which you want to add one or more hosts.

e. Select the hosts from the list that you want to add to the database; then click OK and Yes.

Note: You will need to enter the database password (the database password for the
Vertica dbadmin user is dbadmin. You must click OK several times to complete this step.

18. After completing the previous step, Vertica automatically starts the rebalancing process to
populate the new hosts with data:
a. When prompted, enter the path to a (large) temporary directory that the Database Designer
can use to rebalance the data in the database; then select OK.

b. Either press enter to accept the default K-Safety value, or enter a new higher value for the
database; then select OK. See the Vertica Administrator's Guide for more information.
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c. Select the option that enables HP Vertica to immediately start rebalancing the database.
d. Review the summary of the rebalancing process; then select Proceed.

19. Designate the IP address of one of the newly added Vertica nodes as the representative node for
the cluster.

20. Do the following to remove the Operations Analytics All-in-One for HP OneView Appliance Vertica
instance from the new Vertica cluster. Perform this action from the newly designated
representative node.

a. Runthe /opt/vertica/bin/admintools command as the Linux dbadmin user.
b. Select Advanced Tools

c. Select Cluster Management

d. Select Remove Host(s)

e. Select the Operations Analytics database.

f. Select the box for the Operations Analytics All-in-One for HP OneView Appliance.

Vertica will go through another rebalancing process, then remove the HP OneView Vertica.

Task 5: Installing a New Collector

Install and configure a new Operations Analytics Collector Appliance by following the instructions
located in the Operations Analytics Installation Guide. Look for the section title Installing and
Configuring the Operations Analytics Collector Appliance.

Note: You will register this newly configured Operations Analytics Collector Appliance in a later
task.

Task 6: Adding a New Logger

Carefully complete the following steps to add a new Logger to support a distributed Operations
Analytics version.

1. Reserve an IP address for an additional Logger server. Create a new virtual appliance or set up
hardware using this new IP address.

2. Install Logger using the instructions in the Operations Analytics Installation Guide (just as you
would for a regular distributed system).
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3. Install the SysLog Daemon by running the
<path>/ArcSightSmartConnectors/current/bin/runagentsetup.sh script as the root user.

4. Run the following command to register Logger with the new Operations Analytics Server
Appliance:

/opt/HP/opsa/bin/opsa-log-integration-config.sh -loginUser <tenant username> -
loginPassword <tenant user password> -add -host <fully-qualified domain name of
Logger> -collectorHost <fully-qualified domain name of Collector host> -

username <loggeruserl> -loggerType arcsight -password <loggeruserlpwd> -port
443 -sslEnabled true -base64Decode true -allFields true -tcpMode passive

5. Complete the following steps to configure the arcsight_log_stream collection:

a. Run $OPSA_HOME/bin/opsa/opsa-collection-setup.sh script.

Note: You will be prompted for authentication credentials. See the Operations Analytics
Administrator to obtain the configured authentication credentials, as the default password
changed during the Operations Analytics installation. The default user name is
opsatenantadmin and the default password changed during the Operations Analytics
installation.

b. The opsa-collection-setup.sh script displays alist of connected Collector Appliances.
Select the Collector Appliance you want to configure.

Note: This step depends on there being at least one connected Collector Appliance.

c. Enter 9 to begin configuring an HP ArcSight Logger Collection.
d. When prompted, choose the following option: 5: Log Analytics-All Fields (130)
e. Enterthe HP ArcSight Logger host name from which to collect the data.

f. Enter execute 9 active and wait for the setup process to complete.

Note: The setup process can take several minutes to complete.

g. Enterexit afterthe setup process completes.
h. When prompted to confirm your setup, enter y to exit the script.

6. Install the HP OneView SysLog Daemon parser by copying the following file from the Operations
Analytics All-in-One for HP OneView Appliance to the same location on the new Logger server :
/opt/HP/arcsight/ArcSightSmartConnectors/current/user/agent/flexagent/syslog/On
eViewMapping.sdkrfilereader.properties
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7. Run the following command, as root, to start the SysLog Daemon: Service Arc_SyslLog start

8. Gotothe Logger console and disable the UDP Receiver. Make sure that the Smart Receiver is
enabled.

Task 7: Adding a New Operations Analytics
Server

Carefully complete the following steps to add a new Operations Analytics Appliance to support a
distributed Operations Analytics version.

1. Reserve an IP address for a new Operations Analytics Server Appliance. Create a new virtual
appliance or set up hardware using this new IP address.

2. Deploy the Operations Analytics Server Appliance using instructions in the Operations Analytics
Installation Guide.

3. Complete this step to copy the zookeeper files from the Operations Analytics All-in-One for HP
OneView Appliance to the Operations Analytics Server Appliance. Do the following from the
Operations Analytics All-in-One for HP OneView Appliance:

a. Change directories to /opt/HP/opsa/zookeeper/data/

b. Run the following command: tar -cvf /tmp/zoo.tar version-2

c. Copy the zoo.tar fileto /tmp/zoo. tar file on the Operations Analytics Server Appliance.
Do the following from the new Operations Analytics Server Appliance:

a. Run the following command as the opsa user: mkdir /opt/HP/opsa/zookeeper/data

b. Change directories to /opt/HP/opsa/zookeeper/data

¢. Runthe following command: tar -xvf /tmp/zoo.tar

d. Verify that the version-2 directory now resides in the /opt/HP/opsa/zookeeper/data
folder.

4. Runthe opsa-server-postinstall.sh script using the -scaleout syntax shown below. When
prompted, specify the IP address of one of the new Vertica systems.

/opt/HP/opsa/bin/opsa-server-postinstall.sh -scaleout

After the opsa-server-postinstall script finishes, run the following commands:
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a. opsa-zookeeper restart

b. opsa-server restart

Note: After running an opsa-server restart command, information logged in the
/opt/HP/opsa/log/opsa-server. log file is removed. To view the files that retain this
information across restarts, see the log files located in the
/opt/HP/opsa/jboss/standalone/log directory. Look for log file names that begin with
server.log.

5. Run the opsa-collector-postinstall.sh script shown below. When prompted, specify the IP address
of one of the new Vertica systems.
/opt/HP/opsa/bin/opsa-collector-postinstall.sh

6. Run the following command to register the newly added Operations Analytics Collector Appliance
with the new Operations Analytics Server Appliance:
/opt/HP/opsa/bin/opsa-collection-config.sh -register -collectorhost <fully-
qualified domain name of Newly Added Operations Analytics -port 9443 Collector>
-username opsatenantadmin

7. Run the following command to register Logger with the new Operations Analytics Server
Appliance:

/opt/HP/opsa/bin/opsa-log-integration-config.sh -loginUser <tenantadminl> -
loginPassword <tenantadminlPwd> -add -host <fully-qualified domain name of
Logger> -collectorHost <fully-qualified domain name of Collector host> -
username <loggeruserl> -loggerType arcsight -password <loggeruserlpwd> -port
443 -sslEnabled true -base64Decode true -allFields true -tcpMode passive

8. Complete the following steps to register all of the original collections on the new Operations
Analytics Server Appliance

a. Run the following command: /opt/hp/opsa/support/publishOneViewCollections.sh
PUBLISH <ovHOst> <ovUser> <ovPw> <collectorIP> <loggerIP>
<opsaTenantAdminUser> <opsaTenantAdminPasswd> 3600

Note: publishOneViewCollections.sh is an unsupported script used for troubleshooting
and support purposes.

Note: Review the following information before using the publishOneViewCollections.sh
script:

o PUBLISHis akeyword.

o ovHost, ovUser, and ovPw are the HP OneView credentials used when enabling the
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Operations Analytics - HP OneView integration from the Operations Analytics
welcome page.

o The collectorlP is the hostname of the original Operations Analytics All-in-One for HP
OneView Appliance (Do not use the IP address).

o The loggerlP is the hostname of the new Logger server,

o The last argument is optional, and specifies the metrics collection frequency (in
seconds).

Congratulations, you finished converting your Operations Analytics All-in-One for HP OneView
Appliance version 2.31 into a distributed version of Operations Analytics version 2.31.

Troubleshooting Actions for Expanding to a
Distributed Operations Analytics

If you encounter errors when running (and rerunning) the publishOneViewCollections.sh PUBLISH
command, run the following series of commands before running the publishOneViewCollections.sh
PUBLISH command again:

Note: publishOneViewCollections.sh is an unsupported script used for troubleshooting and
support purposes.

/opt/vertica/bin/vsql -c "drop view IF EXISTS opsa_default.oneview_inventory_
server_view cascade;" -d <dbname> -U <dbuser> -w <db passwd> -h <vertica hostname>

/opt/vertica/bin/vsql -c "drop view IF EXISTS opsa_default.oneview_inventory
enclosure_view cascade;" -d <dbname> -U <dbuser> -w <db passwd> -h <vertica
hostname>

/opt/vertica/bin/vsql -c "drop view IF EXISTS opsa_default.oneview_inventory_
powerdevice view cascade;" -d <dbname> -U <dbuser> -w <db passwd> -h <vertica
hostname>

/opt/vertica/bin/vsql -c "drop view IF EXISTS opsa_default.oneview _metrics_server_
view cascade;" -d <dbname> -U <dbuser> -w <db passwd> -h <vertica hostname>

/opt/vertica/bin/vsql -c "drop view IF EXISTS opsa_default.oneview_metrics_
enclosure_view cascade;" -d <dbname> -U <dbuser> -w <db passwd> -h <vertica
hostname>

/opt/vertica/bin/vsql -c "drop view IF EXISTS opsa_default.oneview_metrics_
powerdevice _view cascade;" -d <dbname> -U <dbuser> -w <db passwd> -h <vertica
hostname>
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/opt/vertica/bin/vsql -c "drop view IF EXISTS opsa_default.oneview_alerts_server_
view cascade;" -d <dbname> -U <dbuser> -w <db passwd> -h <vertica hostname>

/opt/vertica/bin/vsql -c "drop view IF EXISTS opsa_default.oneview_alerts_
enclosure_view cascade;" -d <dbname> -U <dbuser> -w <db passwd> -h <vertica
hostname>

/opt/vertica/bin/vsql -c "drop view IF EXISTS opsa_default.oneview_alerts_
powerdevice_view cascade;" -d <dbname> -U <dbuser> -w <db passwd> -h <vertica
hostname>

/opt/vertica/bin/vsql -c "drop view IF EXISTS opsa_default.oneview_logs server_view
cascade;" -d <dbname> -U <dbuser> -w <db passwd> -h <vertica hostname>

/opt/vertica/bin/vsql -c "drop view IF EXISTS opsa_default.oneview logs_enclosure_
view cascade;" -d <dbname> -U <dbuser> -w <db passwd> -h <vertica hostname>
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After you have expanded the Operations Analytics All-in-One for HP OneView Appliance to a
distributed environment, use the information in the Operations Analytics Configuration Guide to
configure all metrics, events, inventory, and topology collections.
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After you purchase and apply an Operations Analytics production license, use the information in this
section to manage the data retention for Operations Analytics, including both Logger and Vertica.

Managing Vertica Data

By default, the Operations Analytics- HP OneView deployment uses the Vertica Community Edition
license, which is a non-expiring 1TB license. To avoid any disruptions in service, it is a good practice to
monitor the size of the Operations Analytics database.

To check or verify the size of the Operations Analytics database, do the following:
1. Logon tothe Vertica server as an opsa user.
2. Run the following command to become the root user: su -
3. Run the following command to become the Linux dbadmin user: su - dbadmin

4. Run the following command: /opt/vertica/bin/vsql -U dbadmin -c 'select get_
compliance_status();"

Note: Only use the -U dbadmin option if you log on as a root user.

5. Review the compliance status. The message you see resembles the following example, which
shows a 70 percent utilization percentage (70 percent of the 1TB that is available is currently in
use):

get_compliance_status

Raw Data Size: 0.00TB +/- 0.00TB

License Size BT B

Utilization @

Audit Time 12-31 17:00:00-07

Compliance Status : The database is in compliance with respect to raw data size.

No expiration date for a Perpetual Ticense
(1 row)

If you have exceeded your licensed database size, do one or more of the following:

= Shorten the data retention period: See "Setting the Data Retention Period" on the next page
for more information.
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m Set a Purge Policy for the Vertica database: See Purging Deleted Data in the Vertica
Administrator's Guide.

= Manually purge data from the Vertica database: See Purging Deleted Data in the Vertica
Administrator's Guide

m Increase the Vertica license size: See Managing Licenses in the Vertica Administrator's
Guide

See Monitoring Database Size for License Compliance in the Vertica Administrator's Guide for more
information.

Setting the Data Retention Period

By default, the Operations Analytics All-in-One for HP OneView Appliance includes a two month data
retention period. After purchasing and applying a production license, you can modify the data retention
period as follows:

« Toset the retention period for a specific source, domain, and group, use the following command:
/opt/HP/opsa/bin/opsa-collection-config.sh -setretention <retention period in
months> -source <source> -domain <domain> -group <group> -username <username> |-
force]

« To set the retention period for a specific source, use the following command:
/opt/HP/opsa/bin/opsa-collection-config.sh -setretention <retention period in
months> -source <source> -username <username> [-force]

« Toset the overall retention period, use the following command: /opt/HP/opsa/bin/opsa-
collection-config.sh -setretention <retention period in months> -username
<username> [-force]

After setting the retention period for specific collections belonging to a tenant, Operations Analytics
removes any data record with a time stamp older than the listed retention period for those collections.

See the opsa-collection-config. sh reference page (or the Linux manpage) for more information.

Managing Data in Logger

Logger supports several storage groups, each of which can have a different retention policy. Retention
policy is specified in terms of number of days that events are stored, or overall maximum size (in GB).
See Retention Policy in the ArcSight Logger Administrator's Guide for more information.

For software Loggers, the storage volume is set to the maximum capacity specified in the license or the
available disk space, whichever is smaller. See Storage Volume in the ArcSight Logger Administrator's
Guide for more information.

To manage adherence to the Logger license, do the following from the ArcSight Console:
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1. Click System Admin.
2. Click License & Update.

3. Review the license information. If you have exceeded your licensed database size, do one or more
of the following:

m Increase the Logger licensed capacity. See License and Update in the ArcSight Logger
Administrator's Guide for more information

= Add a storage group to Logger. See Adding Storage Groups in the ArcSight Logger
Administrator's Guide for more information

m Regularly manage your Logger storage volume. See Storage Volume in the ArcSight Logger
Administrator's Guide for more information
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Chapter 7: Upgrading an HP Operations
Analytics All-in-One for HP OneView
Appliance to a Newer Version

To upgrade a version 2.30 Operations Analytics All-in-One for HP OneView Appliance to a version 2.31
Operations Analytics All-in-One for HP OneView Appliance, do the following:

1. Follow the instructions shown in "Setting up the HP Operations Analytics All-in-One for HP
OneView Appliance " on page 7 to create a new version 2.31 Operations Analytics All-in-One for

HP OneView Appliance.

Note: Do not integrate the HP OneView server until you are directed to in a later step. .

Note: If you are using DHCP for the Operations Analytics All-in-One for HP OneView
Appliance IP address, the DHCP IP address that you use should not be changing during a
reboot. If the DHCP IP address changes for the Operations Analytics All-in-One for HP
OneView Appliance, Operations Analytics will not function correctly.

2. Preparing for a potential rollback:

It is recommended that you complete a snapshot of both the version 2.30 and 2.31 Operations
Analytics All-in-One for HP OneView Appliances as a precaution.

3. Do the following to stop the Operations Analytics processes on both the Operations Analytics 2.30
and 2.31 Operations Analytics All-in-One for HP OneView Appliances:

a. Logonas anopsa user.
b. Run the following commands:
i. /etc/init.d/opsa-loader stop
ii. /etc/init.d/opsa-process-manager stop
iii. /etc/init.d/opsa-server stop
iv. /etc/init.d/opsa-collector stop

Wait a minimum of ten minutes for all processes to stop and for any intermediate collection
data to be written to the database.

4. Run the following command as the root user to stop the Syslog Daemon Smart Connector on the
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version 2.30 Operations Analytics All-in-One for HP OneView Appliance: /etc/init.d/arc_
syslog stop

5. Do the following on both the Operations Analytics 2.30 and 2.31 Operations Analytics All-in-One
for HP OneView Appliances to configure the absolute IP address rather than the loopback IP
address:

a. Logonas aopsauser.
b. Run the following command to become the root user: su -
c. Run the following command to become the Linux dbadmin user: su - dbadmin
d. Runthe /opt/vertica/bin/adminTools command.
e. Toshut down the Vertica database, do the following:
i. From the Main Menu, select Advanced Menu.

ii. Select option 2: Stop Vertica on Host.

iii. From the Select Host(s) window, select the host box; then click OK.

iv. When prompted about whether you are sure you want to stop Vertica, click yes.

v. From the Main Menu, select View Database Cluster State to make sure that Vertica is
shut down.

f. Log on as the root user.
g.- Run the following command: /opt/HP/opsa/scripts/ScaleOut.sh SETVERTICAROOT.

h. Specify the absolute DNS IP address of the Operations Analytics All-in-One for HP OneView
Appliance.

Note: By default the 127.0.0.1 loopback IP address is used by Vertica on the Operations
Analytics All-in-One for HP OneView Appliance. Do not use that address, because it will
not work for exporting data.

Wait for the script to finish.

i. Logon as the Linux dbadmin user on both the Operations Analytics 2.2 and 2.3 Operations
Analytics All-in-One for HP OneView Appliances:

i. Logon as anopsa user.

ii. Run the following command to become the root user: su -
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iii. Run the following command to become the Linux dbadmin user: su - dbadmin

j- Do the following on both the Operations Analytics 2.30 and 2.31 Operations Analytics All-in-
One for HP OneView Appliances to start each database:

i. Runthe /opt/vertica/bin/adminTools command.
ii. Start the database.

6. To export the data from the version 2.30 Operations Analytics All-in-One for HP OneView
Appliance to the version 2.31 Operations Analytics All-in-One for HP OneView Appliance, do the
following from the version 2.30 Operations Analytics All-in-One for HP OneView Appliance:

a. Create an executable script, script. sh, that contains the following commands:
#!/bin/sh
column_names="vsql -c "select column_name from columns where table_
schema="$5"' and table name='$6'" -d opsadb -w $4 -t | awk -VvORS=, '{ print
$1}' | sed 's/\,,$//"
connect_cmd_to_run="connect to vertica opsadb user dbadmin password '$3' on
'$1, $2;"
export_cmd_to_run="export to vertica opsadb.$5.$6 ($column_names) from $5.%$6
($column_names);"
disconnect_cmd_to_run="disconnect opsadb;"
echo "Connecting to destination database opsadb on $1 at port $2 and running
export";
echo $export_cmd_to_run;
vsql -d opsadb -w $4 -c "$connect_cmd to_run$export cmd_to run$disconnect
cmd_to_run";

b. Run the following script as the Linux dbadmin user on the version 2.30 Operations Analytics
All-in-One for HP OneView Appliance for each table value shown below. Substitute one table
value each time you run the command. Use the table values in the order they appear below:
script.sh <destination version 2.31 database IP Address> <destination
version 2.30 database port> <destination version 2.31 database password>
<source version 2.30 database password> opsa_default <table name>

For example, to export the arcsight_log stream table values using default passwords for
the dbadmin database user on both the source and destination databases, and using 5433 as
the default port, the command would look like this: . /script.sh <destination version
2.31 database IP Address> 5433 dbadmin dbadmin opsa_default arcsight log
stream

List of opsa_default schema table values:
oneview_rabbitmq_alerts
oneview_rabbitmg_metrics
oneview_rest_inventory
oneview_rabbitmqg_inventory update
oneview_rest_topologytree
oneview_rest_interconnect_metrics
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arcsight_oneview_oneviewsyslogs
la_metrics
la_user_classification
la_cluster_frequency
la_samples_queue
la_metric_management
la_user_searches
la_custom_searches
la_parameter_values
la_parameter_functions
arcsight_log_stream
la_cluster_ranking
la_cluster_distribution
la_multiplier

la_problem _cause_properties
la_problem cause
la_technologies
la_unique_msg
la_cluster_parameter
la_clustered_msg

c. Runthe following script as the Linux dbadmin user on the version 2.30 Operations Analytics
All-in-One for HP OneView Appliance for each a table value shown below. Substitute one
table value each time you run the command. Use the table values in the order they appear
below:
script.sh <destination version 2.31 database IP Address> <destination
version 2.31 database port> <destination version 2.31 database password>
<source version 2.30 database password> opsa_admin <table name>

For example, to export the arcsight_log stream table values using default passwords for
the Vertica dbadmin database user on both the source and destination databases, and using
5433 as the default port, the command would look like this: . /script.sh <destination
version 2.31 database host name> 5433 dbadmin dbadmin opsa_admin la_log
level

List of opsa_admin schema table values:
la_log level

la_ootb_searches
la_user_defined_problem_events

7. Do the following on both the version 2.30 and 2.31 Operations Analytics All-in-One for HP
OneView Appliances to start the Operations Analytics processes:

a. Login as an opsa user.
b. Run the following command: opsa-process-manager.sh start

c. Wait five minutes for all of the Operations Analytics processes to start up.
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8. Toexport and import custom dashboards, do the following:

a. From the version 2.30 Operations Analytics All-in-One for HP OneView Appliance, log on as
an opsa user.

b. Forevery custom dashboard that you developed, run the following command:
opsa-dashboard-manager.sh -u <dashboard creation user> -e "“<dashboard name>
-f <export_file_name_with_path>

c. As anopsa user, remote copy the exported files to the version 2.30 Operations Analytics All-
in-One for HP OneView Appliance.

d. Logon tothe version 2.31 Operations Analytics All-in-One for HP OneView Appliance as an
opsa user and run the following command for every exported file to import them into the
version 2.31 Operations Analytics All-in-One for HP OneView Appliance:

opsa-dashboard-manager.sh -u <As user> -i -f <export_file_name_with_path>

e. From the version 2.31 Operations Analytics All-in-One for HP OneView Appliance server, run
the following command as the opsa user to restart the Operations Analytics processes:

opsa-server restart

Note: After running an opsa-server restart command, information logged in the
/opt/HP/opsa/log/opsa-server. log file is removed. To view the files that retain this
information across restarts, see the log files located in the
/opt/HP/opsa/jboss/standalone/log directory. Look for log file names that begin with
server.log.

9. The approach for this step is to connect the Logger instance from the version 2.30 Operations
Analytics All-in-One for HP OneView Appliance to the version 2.31 Operations Analytics All-in-
One for HP OneView Appliance in parallel with the Logger instance already running on the version
2.31 Operations Analytics All-in-One for HP OneView Appliance.

Using this approach, when you search for raw logs using the Operations Analytics 2.31, the
results will include raw logs from both of the following:

m The version 2.30 Operations Analytics All-in-One for HP OneView Appliance Logger (all the
logs collected during the time the you were running Operations Analytics 2.30)

m The version 2.31 Operations Analytics All-in-One for HP OneView Appliance Logger (the logs
collected after you provisioned Operations Analytics 2.31).

You can keep the version 2.30 Operations Analytics All-in-One for HP OneView Appliance Logger

instance connected until the time you no longer want to retain the logs collected from Operations
Analytics 2.30. When you no longer need the logs you are collecting from Operations Analytics
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2.30, disconnect the version 2.30 Operations Analytics All-in-One for HP OneView Appliance
Logger from the version 2.31 Operations Analytics All-in-One for HP OneView Appliance.

To migrate Logger data from a version 2.30 Operations Analytics All-in-One for HP OneView
Appliance to a version 2.31 Operations Analytics All-in-One for HP OneView Appliance, complete
the following steps.

Note: Replace the passwords as appropriate in the following commands.

a. To connect the Logger running on Operations Analytics 2.30 to the version 2.31 Operations
Analytics All-in-One for HP OneView Appliance, do the following:

i. Logon tothe version 2.31 Operations Analytics All-in-One for HP OneView Appliance as
the opsa user.

ii. Run the following command:

opsa-log-integration-config.sh -loginUser <tenantadminl> -loginPassword
<tenantadminlPwd> -add -host <fully-qualified domain name of
Loggerhostl> -collectorHost <fully-qualified domain name of Collector
host> -username <loggeruserl> -loggerType arcsight -password
<loggeruserlpwd> -port 443 -sslEnabled true -base64Decode true -
allFields true -tcpMode passive

b. To disconnect the Logger running on Operations Analytics 2.30 from the version 2.30
Operations Analytics All-in-One for HP OneView Appliance, do the following:

i. Log on tothe version 2.31 Operations Analytics All-in-One for HP OneView Appliance as
the opsa user.

ii. Run the following command:

opsa-log-integration-config.sh -loginUser <tenantadminl> -loginPassword
<tenantadminlPwd> -delete -host <fully-qualified domain name of Logger

host> -collectorHost <fully-qualified domain name of Collector host> -

loggerType arcsight -base64Decode true

c. Totest that you successfully connected and disconnected the Logger running on Operations
Analytics 2.30, run the following command on the version 2.31 Operations Analytics All-in-
One for HP OneView Appliance as the opsa user:

opsa-log-integration-config.sh -list -loginUser opsatenantadmin -
loginPassword opsatenantadmin

10. To migrate the HP OneView configuration from a version 2.30 Operations Analytics All-in-One for
HP OneView Appliance to a version 2.31 Operations Analytics All-in-One for HP OneView
Appliance, do the following:
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a. Point your browser to the version 2.31 Operations Analytics All-in-One for HP OneView
Appliance by entering the following URL: http://<Operations Analytics2.31
VM>:8080/opsa; then log on as the opsatenantadmin user.

b. Click the Settings button on the top right; then select Oneview Settings:

i. Inthe resulting dialog, supply the HP OneView hostname, HP OneView username, HP
OneView password, and polling frequency as specified in the version 2.30
Operations Analytics All-in-One for HP OneView Appliance.

ii. Click Integrate and wait for a Success message to appear.
iii. Close the dialog.

This completes the migration of the version 2.30 Operations Analytics All-in-One for HP OneView
Appliance to a version 2.31 Operations Analytics All-in-One for HP OneView Appliance.

Rollback

If at any point if you want to revert back to the original version 2.30 Operations Analytics All-in-One for
HP OneView Appliance or version 2.31 Operations Analytics All-in-One for HP OneView Appliance,
revert back to the snapshot you took earlier in "Preparing for a potential rollback: " on page 60
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Chapter 8: Upgrading an HP Distributed
Operations Analytics for HP OneView to a
Newer Version

To upgrade version 2.30 Operations Analytics All-in-One for HP OneView Appliance distributed servers
to version 2.31 Operations Analytics All-in-One for HP OneView Appliance distributed servers, do the
following:

1. Follow the steps specified in the Operations Analytics 2.30 to 2.31 Upgrade Guide (for Operations
Analytics version 2.31) to upgrade the Operations Analytics All-in-One for HP OneView Appliance

distributed servers to version 2.31.

2. Do the following to integrate the new version 2.31 HP OneView setup with the HP OneView
server:

a. Point your browser to the Operations Analytics 2.31 by typing the following URL:
http://<opsa2.31 server vm>:8080/opsa; then log on as the opsatenantadmin user.

b. Click the Settings button on the top right; then select Oneview Settings:

i. Inthe resulting dialog, supply the HP OneView hostname, HP OneView username, HP
OneView password, and polling frequency as specified in the version 2.30
Operations Analytics All-in-One for HP OneView Appliance.

ii. Click Integrate and wait for a Success message to appear.
iii. Close the dialog.

This completes the upgrade of a version 2.30 Operations Analytics All-in-One for HP OneView
Appliance distributed server to a version 2.31 Operations Analytics All-in-One for HP OneView
Appliance distributed server.
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Use the information in this section to complete any necessary maintenance tasks.

Backing up and Restoring Data

To back up data for the Operations Analytics All-in-One for HP OneView Appliance, make it a practice
to take regular snapshots. You can use a snapshot if you experience a need to recover your data.

Changing the HP OneView Server

To change the HP OneView server used by Operations Analytics, do the following:

1. Run the following command to unregisterthe Operations Analytics All-in-One for HP OneView
Appliance collections: /opt/HP/opsa/support/publishOneViewCollections.sh UNREGISTER
<collector fully-qualified domain name> <opsaTenantAdminUser>
<opsaTenantAdminPasswd>

Note: publishOneViewCollections.sh is an unsupported script used for troubleshooting and
support purposes.

This script can run for 30 minutes or more. You must wait until the script completes to continue.

2. Configure the Operations Analytics - HP OneView integration using information about the new HP
OneView server by following the instructions at "Configuring the HP Operations Analytics - HP
OneView Integration" on page 31.

Restarting Operations Analytics Processes

There are times when the Operations Analytics All-in-One for HP OneView Appliance might abruptly
shut down, as in during a power outage, network issue, or other unintended shutdown. For the
Operations Analytics processes to function correctly, the Vertica database must completely start up
before restarting the Operations Analytics processes. If the Vertica database is not available when the
Operations Analytics processes start up, these processes might not function correctly.

To make sure the Operations Analytics processes start up correctly, do the following
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1. Do the following to verify that the Vertica database is running.

a. Runtheopsa-db status command as the root user.

Note: Supply the dbadmin user's password when prompted. Typically the password is
dbadmin.

b. If the Vertica database is up, you should see a message that states that the database is up.

If the database is not up, wait a few minutes, then rerun the opsa-db status command.

Note: Do not start the Operations Analytics processes until the Vertica database is
running.

2. Do the following to start the Operations Analytics processes:

a. Runtheopsa start command.

b. Afterfive minutes, check to see that you can open the Operations Analytics console .

c. Ifthe Operations Analytics console is not accessible, run the service opsa-server
restart command to reboot the Operations Analytics All-in-One for HP OneView Appliance.

Note: After running an opsa-server restart command, information logged in the
/opt/HP/opsa/log/opsa-server.log file is removed. To view the files that retain this
information across restarts, see the log files located in the

/opt/HP/opsa/jboss/standalone/log directory. Look for log file names that begin with
server.log.
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Chapter 10: Operations Analytics Security
Hardening

The information in this sections summarizes the security hardening recommendations for the
Operations Analytics All-in-One for HP OneView Appliance.

Miscellaneous Security Recommendations

Anti-virus Software

The Operations Analytics All-in-One for HP OneView Appliance is compliant with your anti-virus
software. Use your preferred anti-virus software.

It is recommended that you scan the following folders:
« The path to the folder containing scripts: /opt/HP/opsa/scripts

« The path to the folder containing alerts
scripts: /opt/HP/opsa/inventory/lib/user/alerts/

« The path to the folder you use for uploading files. For example, you might upload files to the
/opt/HP/opsa/data folder.

Disabling Unnecessary CentOS Services

Complete the following actions to make your Operations Analytics installation more secure:

« Itis highly recommended that you disable the SSH weak ciphers. To do this, the configuration
entries already reside in the sshd_config file and need to be uncommented as follows:

Note: Not all SSH clients support the new ciphers. Make sure that your SSH client supports
them.

a. As theroot user, edit the sshd_config file.

b. Touncomment the following two lines, change:
# Ciphers aesl128-ctr,aesl92-ctr,aes256-ctr,arcfour256,arcfourl28,aesl28-
cbc,3des-cbc
# MACs hmac-md5,hmac-shal,umac-64@openssh.com,hmac-ripemd160

to
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Ciphers aes128-ctr,aesl92-ctr,aes256-ctr,arcfour256,arcfourl28,aes128-
cbc, 3des-cbc
MACs hmac-md5,hmac-shal,umac-64@openssh.com,hmac-ripemd160

c. Save yourwork.

d. As aroot user, run the following command to commit your changes: service sshd restart

Arcsight Logger Security Recommendations

As a minimum requirement, run Arcsight Logger at the application level privilege.

Note: When creating a user, assign the least amount of privileges needed for the user to perform
that user's tasks

Avoid co-locating Logger with another software application.

Minimize the number of operating system level users. If passwords are used, you must implement
hard-to-guess passwords. When creating hard-to-guess passwords, combine length with complexity to
make the passwords difficult to guess or compromise using forceful methods. At a minimum, use long
passwords when complexity cannot be used.

To mitigate the risk of exposing the authentication token cookie in case of a client side attack, do the
following:

« Set the inactivity timeout to a short duration.
Note: The default value for Logger is 15 minutes.

« Explicitly log out of Logger.
« Do not click links in emails or browse the web in the same browser being used to view Logger.

« LogontoLogger as a user that has only the necessary privileges.
Note: Do not log on as a user having administrator privileges.

To reduce the attack surface, do the following:
« Configure the firewall to permit only the following ports for inbound Traffic
= TCP port 9000

m TCP port 22
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Note: sshis not required byLogger, however it is useful for troubleshooting purposes.

« Limit the outbound traffic to the following ports:

s TCP port 22

Note: This port is used for backups, however a user can specify a different port (that should
be configured to be open in the firewall).

TCP port 25

Note: Used for SMTP.

TCP port 9000

Note: Used for communicating with other Loggers(for peering).

UDP and TCP port 53

Note: Used for DNS.

UDP port 123

Note: Used for NTP.

« If possible, filter on source IP addresses.

Do the following for ongoing Logger maintenance:
« Install operating system and application security fixes diligently.
« Carefully monitor log files and audit logs.

« Consider performing file integrity checks

Note: For example use software applications such as Tripwire to perform file integrity checks.
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Send Documentation Feedback

If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on HP Operations Analytics for HP OneView Installation, Integration, and Upgrade
Guide (Operations Analytics 2.31)

Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a web mail client, and
send your feedback to sw-doc@hp.com.

We appreciate your feedback!
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